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Skill Set 5
Outlines and Complex
Functions

By the end of this Skill Set you should be able to:

Create an Outline
Work with an Outline
Create Automatic Subtotals
Use a variety of Complex Functions
Use Nested Functions
Use Array Formulas
Correct Formulas that Produce Errors
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Exercise 37 - Creating an Outline
Knowledge:
An Outline is used to hide parts of a worksheet, making it easier to see the more
important areas. Different users may need to see different information or different
amounts of information.
An outline can show up to eight different levels, both horizontally and vertically, with
each level showing a different amount of data. The levels are displayed or hidden
to show the required data.

Activity:
1.

Open the workbook Home.

2.

Display the Data tab and click the Group button drop down list and select
Auto Outline. Excel assumes that the summary rows (the formulas) are at
the bottom of the detail and the summary columns are to the right.

Level
Buttons

Row
Level
Bars

Hide
Buttons

3.

The outline has been created. It has 3 row levels and 2 column levels. Notice
the various buttons and bars above and to the left of the worksheet.

4.

Row and column level buttons,
, indicate the number of levels in an
outline. Click on them to display a specific level - the lower the number, the
less detail is displayed.

5.

To remove the Auto Outline, on the Data tab, click the Ungroup drop down
list and select Clear Outline. The outline is removed.

6.

Close the workbook without saving.
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Exercise 38 - Working with an Outline
Knowledge:
Outlines are used to restrict the amount of data seen on a worksheet. When an
outline is created, the levels appear around summary rows and columns, as these
are usually the most important areas of a worksheet. Levels can be expanded and
collapsed using the level buttons as described in the last exercise.

Activity:
1.

Open the workbook Outline.

2.

To add an Auto Outline to the worksheet, click the Group button drop down
on the Data tab and select Auto Outline.

3.

The outline is fully expanded. It has 4 row levels and 2 column levels. Hide
the first level of rows by clicking on the row level button 3. This is one level
down. Only the totals are shown for Turnover and Spending, the detailed
lines are hidden.

4.

Hide more rows by clicking on the Hide Detail symbol,
, for the second
level. Turnover and Spending are now hidden behind the Profit row.

5.

Hide all columns and rows by clicking on the row level button 1 and the
column level button 1. The worksheet is now fully collapsed, showing only
Tax and Net Profit for the whole year.

6.

Display the rows to the third level by clicking on the row level button 3.

7.

Click on the Show detail symbol,
behind the Spending row.

8.

Practise showing and hiding levels using the

Note:

, next to row 10 to display the detail

and

symbols.

Levels can also be hidden by clicking the black line associated with each of
the Hide levels buttons, .

9.

To remove the Auto Outline, click the Ungroup drop down list and select
Clear Outline. The outline is removed.

10.

Rows and columns can be highlighted and an outline added manually, if the
Auto Outline is not satisfactory. Highlight rows 2 and 3, then click Group to
add an outline level to row 4.

11.

Highlight rows 5 to 9 and group them to add an outline at the same level (the
rows are not overlapping).

12.

Highlight rows 2 to 13 and Group them. Because this overlaps an existing
group, a new outline level is added.
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Exercise 38 - Continued
13.

Highlight columns B to M and group them to add a horizontal outline. An
Outline has now been manually created with 3 row levels and 2 column
levels, as shown below:

14.

Collapse all the levels.

15.

Expand all the levels and highlight rows 2 and 3, then click the Ungroup
button to remove a part of the Outline.

16.

To remove the whole outline, make sure that no rows or columns are
selected, click the Ungroup drop down list and select Clear Outline.

17.

Close the workbook without saving.
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Exercise 39 - Adding Automatic Subtotals
Knowledge:
Automatic Subtotals can be added to any list that has been sorted. At each change
in the column data, Subtotal inserts a row and calculates a subtotal. The worksheet
has an Outline added automatically to be able to control the amount of data
viewed.

Activity:
1.

Open the workbook Survey. This workbook is a list of over 200 people that
have been surveyed.

2.

A column must be sorted before adding Subtotals to a list, so that similar
items are placed together. Place the active cell in column F under the title
Town.

3.

On the Data tab, click the Sort A to Z button,
to sort the towns into alphabetical order.

4.

Click the Subtotal button,

5.

Select the Town field within At each change in drop down to match the
sorted column. We want to produce a subtotal each time the Town changes.

6.

Select Count from the Use function drop down list to count the number of
people that have replied to the survey.

7.

In Add subtotal to, the fields to subtotal are defined. Reply is already
checked by default.
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Exercise 39 - Continued
8.

Note:

Click OK to add Subtotals. A count of those records with a Reply is shown
for each Town.
To count all records, pick a field that always has an entry, such as Surname.

9.

An Outline is added where the amount of data displayed can be controlled.
at the top of the Outline Bar on the left to
Click on the second level button
show just the Subtotals.

10.

To expand a subsection click on
South Shields section.

11.

To hide all the Subtotals click the row level button 1, only the Grand Count is
displayed.

12.

To remove subtotals, click on a cell inside the list and then click the Subtotal
button in the Outline group and click the Remove All button.

13.

Close the workbook Survey without saving.
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Exercise 40 - Lookup Functions
Knowledge:
Lookup & Reference functions deal mainly with data in tables or ranges, for
example retrieving values or transposing vertical and horizontal ranges.
A Lookup table consists of a selection of bands, or intervals, where a given value
can be found. There are two functions, HLOOKUP, which searches a horizontal
table and VLOOKUP, which searches a vertical table.

Activity:
1.

Open the workbook Discount. The worksheet consists of a discount
calculation at the top and two lookup tables at the bottom, one horizontal and
one vertical, containing the same data. The discount available depends
directly on the number of items bought.

2.

Click in cell D8. To use the HLOOKUP function, display the Formulas tab,
click the Lookup & Reference button in the Function Library group. Select
HLOOKUP from the list.

3.

The Function Arguments dialog box for HLOOKUP is displayed.

4.

The Lookup_value is cell D4 (number bought). The Table_array is C14:I15
(the table without the labels) and the Row_index_num is 2 (to return the
value from the 2nd row of the table). Move the dialog box as required.

Note:

Setting the Range_lookup to FALSE causes the function to return a value
only if there is an exact match between the Lookup_value and the table
entry.

© CiA Training Ltd 2010

82

Excel 2010

OCR Level 3 ITQ

Spreadsheet Software

Exercise 40 - Continued
5.

Click OK. The value returned is 10%, corresponding to selling between 5 and
9 items.

6.

Change the number bought in D4 to 23. The Discount %, Discount and the
Discount Price all change.

7.

To use the VLOOKUP function, click in cell D8 and delete the contents. Click
the Lookup & Reference button and select VLOOKUP (this function is
similar to HLOOKUP except the base data is stored in columns).

8.

The Lookup_value is cell D4 (number bought). The Table_array is B19:C25
(the table without the labels) and the Col_index_num is 2 (to return the value
from the 2nd column of the table).

9.

Click OK to complete the function.

10.

Change the number bought in D4 to 52. The Discount % changes to 45% the
Discount Price is £2000.57.

11.

Close the workbook without saving
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Exercise 41 - Statistical Functions
Knowledge:
Statistical functions deal with analysing numerical data, from simple counting and
averaging to calculating complex distribution parameters.
There are over 80 different functions within the Statistical category, from the
simple, AVERAGE, COUNT, MAX MIN to more involved, such as, FREQUENCY,
TREND, COUNTIF, GROWTH to the more complex, such as VAR (Variance) and
STDEV (Standard Deviation).
All the functions are easy to construct and produce a solution, the problem with
them is understanding what they do.

Activity:
1.

Open the workbook Invoice. The statistical function we are covering here is
COUNTIF. COUNTIF counts numeric items that match a set condition, e.g. to
count the number of clients that owe more than £100.

2.

Click in cell D16 and enter the label Invoices under £500.

3.

Click in cell E16. Click the More Functions button then Statistical and
COUNTIF.

4.

In the COUNTIF box select the Range as E6:E14.

5.

Set the criteria in the Criteria box to <500.

6.

Click OK. Check the Formula Bar for the formula (the speech marks are
added automatically). The cells that match the condition are counted.

7.

Leave the workbook open.

© CiA Training Ltd 2010

84

Excel 2010

OCR Level 3 ITQ

Spreadsheet Software

Exercise 42 - Maths & Trig Functions
Knowledge:
Math & Trig functions deal with processing individual numerical data, from simple
rounding to complex trigonometric calculations. Some useful functions are: INT,
ROUND, SUMIF and SUBTOTAL.
SUBTOTAL acts on displayed rows when filtering lists. It performs various other
functions within it, using Function_num as a value matching the required one. The
eleven numbers are:
1

AVERAGE

5

MIN

9

SUM

2

COUNT

6

PRODUCT

10

VAR

3

COUNTA

7

STDEV

11

VARP

4

MAX

8

STDEVP

Activity:
1.

The workbook Invoice should be open, if not open it.

2.

In the previous exercise cells matching a set criteria were counted. These
cells can also be summed using SUMIF. In cell D17, enter the label Small
invoices total.

3.

In cell E17 click the Math & Trig button then select SUMIF.

4.

Select the Range as E6:E14. Set the criteria in the Criteria box as <500.

5.

Click OK to paste the function. The invoices that are under £500 are summed.
The formula is similar to COUNTIF except that the cells are added.

6.

Close the workbook without saving.

7.

Open the workbook List. The worksheet data ends at row 225.

8.

Move to cell F226. Click Math & Trig and select SUBTOTAL.

9.

Function_num is the number associated with the function. Type 9 (for sum,
see the list at the top of the page).

10.

Ref1 is the range to act on. Type or select F6:F225 (further references can be
added if required, using Ref2, etc.).

11.

Click OK to complete the function. There should be 44 replies in the whole
list.

12.

With the active cell in the list, click the Filter button on the Data tab to apply
the AutoFilter. Filter Town and select only Sunderland. The Subtotal now
shows the number of replies in the filtered list.
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Exercise 42 - Continued
13.

In cell D226, enter the SUBTOTAL function to find the Average age of the
people in the filtered list. The Function_num is 1 and the Ref1 is the full
range D6:D225.

14.

Click OK to complete the function. The answer should be 50.78.

15.

To make use of this information, SUBTOTAL can be used with the basic
functions Sum, Count, Average, etc. In cell E228, enter the label Replies
and in cell F228 enter the function =COUNT(F6:F225).

16.

In cell E229, enter the label Responses and in F229, the formula =F226 (the
SubTotal). The answer should be 17.

17.

In cell E230, enter the label Percentage and in F230, the formula
=F229/F228. Format the cell as a percentage, with 0 decimal places. This
displays the filtered list replies as a percentage of the total replies. The
answer should be 39%.

18.

Filter the list for a different Town, Newcastle and check the formulas at the
bottom. There should be 5 replies from Newcastle, 11% of the total replies.

Note:

Care should be taken when using rows at the bottom of a list, as new
records may be added. If a list may be expanded in the future, place the
calculations to the right of the list or on another sheet.

19.

Close the workbook without saving.

20.

Open the workbook Personnel and apply the AutoFilter.

21.

Filter Administration from the Department column.

22.

Click on cell H23 and click the AutoSum button. Because the list is filtered,
the SUBTOTAL function is added automatically by the SUM function.

Note:

Check the range to make sure that it covers all the filtered records, if using it
for other filters.

23.

Select Select All from the Department filter. The formula shows a total of all
the absences.

24.

Filter the list to show a different department.

25.

Close the workbook without saving.
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Exercise 43 - Nested Functions
Knowledge:
Individual functions can be combined with each other to form more complex
functions. When one of the values within a function is itself a function, this is known
as a Nested Function. An example of a nested text function is
=UPPER(LEFT(B2,3), which would return the upper case of the left three
characters in the cell B2.
A common use for nested functions is in the IF function, where the logical test, e.g.
A1>10, can be replaced by a logical function, e.g. AND(A1>10,A1<20).
It is vital that the nested function returns a value of the same type as required by the
first function or an error will result. In the above examples, LEFT returns a text field,
which is required for the UPPER function; AND returns a logical value (TRUE or
FALSE) which is required as the first value for the IF function.

Activity:
1.

Open the workbook Absences.

2.

It is decided to pay a £15 bonus to all employees over 40 who have had less
than 2 days absence this year.

3.

Enter the label Bonus in cell G1 and right align the label.

4.

Select cell G2 and click the Logical button from the Formulas tab and select
IF.

5.

In the Logical_test field enter the function AND(E2>=40,F2<2). This AND
checks for the age being 40 or over and the absence being less than 2 days.

6.

Enter 15 in the Value_if_true field and 0 in the Value_if_false.

7.

Click OK to enter the function.

8.

Check the Formula Bar for the completed function in G2:
=IF(AND(E2>=40,F2<2),15,0)

9.

Copy the nested function from G2 to the range G3 to G20 to see who qualifies
for the bonus.

10.

Close the workbook without saving.
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Exercise 44 - Array Formulas
Knowledge:
Array Formulas perform calculations on all the elements of an array of data and
return either a single value or multiple values depending on the function. All array
formulas are displayed with { }, which are automatically added. Multiple value
formula are identical over the whole range and individual cells within the range
cannot be edited or deleted.

Activity:
1.

Open the workbook Sales Trend. This is a spreadsheet showing actual sales
in row 4 and row 5 is to display the trend in the sales figures.

2.

Highlight the range B5:F5 and type the following function =TREND(B4:F4).

3.

To enter the function as an array into the highlighted range hold down
<Ctrl> and <Shift> and press <Enter>. The array is created.

4.

Click on each cell in the range B5:F5, the formula is the same.

5.

Click on cell C5 and delete the cell contents. An error message is displayed,
as part of an Array cannot be changed.

Note:
6.

The entire array has to be selected to format or delete it.
Close the workbook without saving.
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Exercise 45 - Formulas that Produce Errors
Knowledge:
When some formulas are created they produce errors. When a formula cannot be
calculated, the cell displays an error message. All error values begin with a #. The
following are the error types with their associated number:
#NULL!

1

The two areas specified do not intersect

#DIV/0!

2

Division by zero

#VALUE!

3

The wrong argument used

#REF!

4

Cell referenced is not valid

#NAME?

5

Does not recognise text in a formula

#NUM!

6

Error with number in formula

#N/A

7

The value used in the formula is not available

######

The result is too long to fit into the cell. A Tooltip shows
the actual contents of a cell. This is a display error only.

Activity:
1.

Start a new workbook.

2.

In cell B10, enter the number 5 and in C10, enter the number 2.

3.

In cell D10, enter the formula to divide the two numbers, i.e. =B10/C10.

4.

Change the number in cell C10 to 0 (zero). This produces a #DIV/0! error in
cell D10. Click on cell C10 then move the cursor over the error icon
see an explanation. Click on the icon to see some options.

to

5.

The function ERROR.TYPE can also be used to identify the type of error. In
cell E10, enter =ERROR.TYPE(D10). The result is error type 2.

6.

Delete the contents of cell E10.

7.

Using the function IF can prevent some errors. Click on cell D10 and enter the
formula =IF(C10=0,0,B10/C10). The formula is only calculated when the value
in cell C10 is not 0. If C10 is zero, the formula is not calculated and a value of
zero will be used as the result.

Note:

This replacement of the error is performed because if the #Error remains
and it is in the middle of a range, any calculation on the range will display the
same error message.

8.

Change the formula in D10 to =IF(C10=0,"error",B10/C10). This will display
the message error if C10 is zero, without calculating the formula.

9.

Save the workbook as errors and then close it.
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Exercise 46 - Develop Your Skills
You will find a Develop Your Skills exercise at the end of each Skill Set. Work through
it to ensure you’ve understood the previous exercises.
1.

Open the workbook Hotel Outline.

2.

Add an Auto Outline to the worksheet.

3.

Display the row level 3.

4.

Set the display to Landscape, fit to one page and print a copy.

5.

Remove the Auto Outline.

6.

Create a manual outline by grouping rows 4 to 13 and rows 16 to 27. Add
another row level by grouping rows 4 to 31.

7.

Group columns B to M, collapse the columns and then collapse the rows.

8.

Display the hidden columns. Print a copy of the outlined worksheet.

9.

Remove the Outline on rows 4 to 13. Clear all the outlines and close the
workbook without saving.

10.

Open the workbook kitchen36 (created in an earlier exercise or from the
Solutions folder).

11.

The main formulas in Order Details can now be added. Display the Prices
sheet. The prices for the items are found by looking them up from this sheet,
the lookup table is the range A4:H36 and is fixed, e.g. $A$4:$H$36.

12.

Display the Order Details sheet. Click in cell E8. The formula is to be a
nested function. The price is only entered if the type is greater than 1 (none)
and the quantity is greater than 0, AND($C$5>1,D8>0). The lookup function
uses the Reference in column A as the Lookup_value and C5 (type) +2 as
the column to look up from the matching price - see the Types sheet then
Prices.

13.

Enter the formula in E8:
=IF(AND($C$5>1,D8>0), VLOOKUP(A8,Prices!$A$4:$H$36,$C$5+2),0)

Note:

The type of kitchen in cell C5 and the Lookup Table are absolute
references. The type of kitchen in cell C5 is selected later using a drop down
list.

14.

Replicate the formula from E8 down to E40.

15.

Enter a number (from 2 to 6) for the kitchen type in cell C5 and some test data
in column D (number of units) to check that the formulas work. Use the Types
sheet to match the type and then the Prices sheet to check that the correct
values have been used.
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Exercise 46 - Continued
16.

On the Order Details sheet, select cell F8 and enter a formula to multiply
Quantity by Price, =D8*E8. Replicate the formula from F8 down to F40.

17.

In cell F41 use the SUM function to total the prices.

Note:

Testing the functionality of the spreadsheets will be performed later after the
structure has been completed.

18.

In cell C41 enter the text Units (excluding accessories). Format the text
bold and right align it.

19.

In cell D41 sum the range D8:D36. Format bold and centre.

20.

A formula is to be placed in cell F42 that will represent an amount of discount
of 10% on orders £5,000 or over. Enter =IF(F41>=5000,F41*0.1,0) as the
formula. Right align cell F42. Edit the formula in F42 to replace the 0.1 with
the link to cell B10 on the Types worksheet. Make the reference to B10 in the
formula absolute.

21.

In cell F43 calculate the Grand Total, the sub total minus the discount.

22.

Change the Total Price column to currency format, range F8:F43.

23.

In E4 create the customer reference, using CONCATENATE (a Text function)
to combine the customers initials from cells C4 and B4 and the postcode in
cell D4 (separate the initials from the postcode with a /, remembering to
include speech marks around it).

24.

Test this formula by adding your name and postcode to the range B4:D4.

25.

To save entering the current date for every customer, add the NOW function
to cell F5. Format the date in cell F5 to be dd/mm/yy.

26.

To make the worksheet less cluttered the display of zeros can be suppressed.
Click the File tab then Options and in the Advanced section under Display
options for this worksheet uncheck Show a zero in cells that have zero
value. Click OK. Zeros are now not displayed on the worksheet making it
easier to use.

27.

One other minor problem is that the Discount and the Grand Total in
conjunction with Sub Total are sometimes 1 penny out, because of the
accuracy of the calculation. The INT (Integer) function can be used to remove
the pennies from the Discount so that is always a whole number.

28.

Amend the formula in cell F42 to remove the pennies from the Discount:
=IF(F41>=5000,INT(F41*Types!$B$10),0)
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Exercise 46 - Continued
29.

To test the calculations enter the following order:

30.

Leave the data as entered, save the workbook as kitchen46 and close it.

31.

Open the workbook Kitchen Finance. An Array formula is to be created in a
worksheet containing details of the company’s turnover and kitchens sold
over a ten year period. The formula will calculate the Trend (a linear
sequence) for the turnover.

32.

Cell B4 should be the Trend cell for 1998. Select the range of cells B4:K4
and type the formula =TREND(B3:K3) but do not press <Enter>.

33.

An Array formula is entered by holding down <Ctrl Shift> and pressing
<Enter>. Press <Ctrl Shift> and <Enter> to create the single array formula.
Check each cell in the range B4:K4 and note that the formula is the same.

34.

Save the workbook as kitchen finance2 and close it.
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Summary: Outlines and Complex Functions
In this Skill Set you have created and worked with outlines.
You have also created automatic totals, complex functions and sorted out errors in
formulas.
Your OCR ITQ evidence must demonstrate your ability to:
•

•

•

•

Excel 2010

Group and Outline data


Create outlines



Work with outlines

Use formulas that meet calculation requirements:


Mathematical



Statistical



Financial



Logical



Look-up

Understand:


Arguments



Arrays



Nested functions

Sort out errors in formulas:


Check for errors



Use formulas for validating data
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